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FLITECAM Redux Users Manual 
SOF-US-HBK-OP10-2004 

1 INTRODUCTION 

The SI Pipeline Users Manual (OP10) is intended for use by both SOFIA Science Center staff 
during routine data processing and analysis, and also as a reference for General Investigators 
(GIs) and archive users to understand how the data in which they are interested was processed.  
This manual is intended to provide all the needed information to execute the SI Level 2 Pipeline, 
flux calibrate the results, and assess the data quality of the resulting products.  It will also 
provide a description of the algorithms used by the pipeline and both the final and intermediate 
data products.   
 
A description of the current pipeline capabilities, testing results, known issues, and installation 
procedures are documented in the SI Pipeline Software Version Description Document (SVDD, 
SW06, DOCREF).  The overall Verification and Validation (V&V) approach can be found in the 
Data Processing System V&V Plan (SV01-2232).  Both documents can be obtained from the 
SOFIA document library in Windchill at location: / Software Management Development or 
Verification / Pipelines (DPS).    
 
This manual applies to FLITECAM Redux version 1.1.0. 
 

2 SI OBSERVING MODES SUPPORTED 

2.1 FLITECAM instrument information 

The First Light Infrared Test Camera (FLITECAM) is an infrared camera, operating in the 1.0 - 
5.5 μm range.  It has a set of broadband filters for imaging, and a set of grisms and order sorting 
filters for medium resolution spectroscopy. 
 
The FLITECAM imaging mode provides seeing-limited images at 1 – 3 μm and diffraction-
limited images at 3 - 5.5 μm (McLean, et al. 2006).  The array (InSb ALADDIN III) size is 1024 
x 1024 with a pixel scale of 0.47” per pixel.  This configuration results in a Field-Of-View 
(FOV) of ≈ 8.0’ but a circular stop and coma at the edges of the image restrict the usable FOV to 
5.6’ (see the figure below). FLITECAM has two filter wheels that contain a set of broadband 
imaging filters, a suite of broad order sorting filters for spectroscopy and a few narrowband-
imaging filters. Available broadband imaging filters for FLITECAM are J, H, and K.  The 
narrow band filters are Pα, Pα  Continuum, 3.0 μm ice, and 3.30 μm PAH. In future the instrument 
team may offer other filters (Hwide, Kwide, Klong, L, nbL, L’, M, nbM, and L+M) to general 
observers. Detailed information about filter characteristics, saturation limits, sensitivities and 
observation planning can be found in the FLITECAM chapter of the SOFIA Observer’s 
Handbook (SOFIA User Support Group 2013). 
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Figure 1: A typical FLITECAM image obtained during a commissioning flight.  The cyan 

box represents the usable portion of the array.  Sources that fall outside of this box show 
too much coma for accurate PSF measurement.  The small white dots visible in the 

image are hot pixels.  The green ellipse encompasses a region of low quantum efficiency 
and the green arrows show obscurations in the optical path. 

 
FLITECAM also has three grisms and five order-sorting filters that can be combined in different 
ways in order to access the full 1-5 micron wavelength range.  It has two slits, a narrow slit (1”) 
and a wide slit (~2”), which allow for higher (R~2000) or lower (R~1300) resolution, 
respectively. The slits are both 60’’ long and are adjacent to each other on the slit mask, such that 
spectra from both slits are acquired simultaneously during an integration (see Fig. 2). 
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Figure 2: A typical FLITECAM grism observation taken with the wide 
slit.  As with the raw imaging frame, there are hot pixels scattered 

across the frame.  The wide-slit region is outlined in red; the narrow-
slit region is visible to the right of the wide-slit region. Wavelength 

increases from the bottom to the top of the frame. 
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2.2 FLITECAM observing techniques 

In any given pixel on a detector, the total number of counts is given by the sum of the counts 
from the dark current, telescope emission, sky background, and the target itself.  Since the sky 
level can vary significantly over short timescales in the near infrared, it is typical to take pairs of 
observations back-to-back and subtract them in order to remove the dark current, telescope 
signal, and sky signal (to first order).  An A frame exposure of the target is immediately followed 
by a B frame containing only sky at the target’s position: 
 

A = dark + telescope + sky! + target 
B = dark + telescope + sky" 
A-B = target + (sky!-sky")  

 
Note that it is assumed that the sky level may vary somewhat between frame A and frame B, but 
the dark current and telescope emission do not.  For the spectroscopy mode, this residual sky 
emission is typically removed in the extraction process. 
 
For FLITECAM imaging, there are presently two observing modes: stare and nod-off-array. 
Both of these modes can be run with or without dithers. We anticipate that most of the 
observations using FLITECAM will be done either in stare with dither mode for un-crowded 
Field-Of-View (FOV) or nod-off-array with dither for crowded and extended emission FOV.   In 
the first case, all dither positions are combined to produce a sky frame that can be subtracted 
from each image.  In the second case, only the sky frames are combined and subtracted from the 
on-source frames. 
 
FLITECAM grism observations offer two modes for producing the AB pairs.   In the nod-along-
slit mode, the A frame is taken with the target positioned one-third to one-quarter of the distance 
along the slit.  After the A frame is complete, the telescope moves to place the target 
approximately the same distance from the other end of the slit.  The exposure taken in this 
configuration is the B frame.  It is typical, then, to repeat AB pairs in either an A-B-A-B or A-B-
B-A sequence until the total desired integration time is achieved.  In this mode, the A frame 
provides the sky measurement at the target position for the B frame, and the B frame provides 
the sky for the A frame.  This mode is useful as long as the target is compact, relative to the slit 
length. 
 
In the second mode, nod-off-slit, the A frame is taken with the target at the center of the slit.  The 
B frame is taken with the target completely off the slit, so that the exposure contains only the sky 
signal.  In this mode, the B frame exists only to provide the sky measurement at the target 
position for the A frame, which may be useful if the target is significantly extended.  In this 
mode, too, either the A-B-A-B or A-B-B-A observing sequence can be used. 
 
For spectroscopy, it is necessary to observe a flat field and a telluric standard star alongside the 
science observations.  Optionally, for either imaging or grism mode, a dark frame may be 
observed as well.  Standards should be taken in flight, near in time to the science observation.  
Flat fields and dark frames may be taken from the ground, but ideally should be taken the same 
day as the science observations.  The flat field is used to correct for differences in instrumental 
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response across the detector as well as to determine the location of the slit image on the detector.  
The telluric standard is used to correct for absorption from the Earth’s atmosphere, as well as to 
assign physical flux units to the final science spectrum. The dark frame is used to correct for dark 
current in the spectroscopic flat frames.   It is not required for science processing because science 
frames are subtracted, which automatically removes the dark current.  It is optional for the flat 
field processing because the dark current for FLITECAM is expected to be small. 

3 ALGORITHM DESCRIPTION 

3.1 Overview of data reduction steps 

Redux is a software package written in IDL that is designed to be a framework for executing any 
number or combination of data reduction algorithms.  For FLITECAM, it has been developed to 
support seamlessly running image processing algorithms from the FDRP package to reduce 
imaging data, alongside spectral extraction algorithms from the FSpextool package for 
spectroscopy data, and photometry and flux calibration algorithms from the PipeCal IDL 
package.  FDRP is an IDL package developed specifically for FLITECAM imaging, while 
FSpextool was originally developed for use with the SpeX instrument (as Spextool), then was 
adapted for FLITECAM.  PipeCal was developed by the SOFIA Data Processing System (DPS) 
team for general-purpose flux calibration of imaging data.  Redux can run in an automatic batch 
mode, integrated with the SOFIA Data Pipeline System (DPS), or it can run with a graphical 
front end as a quick-look data viewer in flight or during manual data reduction and analysis.  
 
This section will describe, in general terms, the major algorithms used by Redux to reduce a 
FLITECAM observation.  See the figures below for flow charts of how these algorithms fit 
together for spectral and imaging modes.   
 
  



SOF-US-HBK-OP10-2004 
Rev A 

VERIFY THAT THIS IS THE CORRECT REVISION BEFORE USE 
6  

 

 
 
 

Figure 3: Flowchart for imaging reduction 
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3.2 Imaging Reduction algorithms 

The following subsections detail each of the data reduction pipeline steps outlined in the imaging 
flowchart above.  All algorithms in this section are carried out by the FDRP package. 

3.2.1 Nonlinearity correction 
In imaging mode, the pipeline reads the FITS header data to sort the input files by observation 
type (dark, source, or sky, for imaging).  Optionally, it can check the FITS header keywords for 
compliance with requirements at this stage, and abort processing if the requirements are not met.   

Figure 4: Flowchart for spectroscopy reduction 
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It then reads the data into memory, corrects each frame for nonlinearity, and generates an 
uncertainty image that associates an error with each pixel in the raw image. 
 
The nonlinearity coefficients for FLITECAM were determined by taking a series of flat 
exposures with varying exposure times.  The count rates at each pixel in the flats were fit with a 
fourth order polynomial, and the resulting coefficients were stored in a FITS image file as a 3D 
data cube, where each plane corresponds to a different coefficient in the polynomial fit. 
 
Following the Spextool nonlinearity paper (Vacca et al., 2004; see Other Resources, below), the 
coefficients are applied to raw data as follows.  First, the flat pedestal is determined from the first 
plane of the linearity coefficients: 

𝑝#$%& = 𝐶'	𝛿𝑡#$%&, 
where C0 is the first coefficient plane, and δtflat is the readout time for the flats used to determine 
the linearity coefficients.  The pedestal for the image to be corrected is determined iteratively.  
The first estimate of the pedestal is: 

 𝑝()) = +!"!	-&	
.#.$/&

:.#0)
1
− 𝑓=, 

where Stot is the raw counts in the image, nr is the number of readouts, nc is the number of 
hardware coadds, δt is the readout time, Δt is the integration time, and f is a fractional value 
indicating how long it takes for an individual pixel to be readout.  Rigorously, f varies for each 
pixel, depending on its position in the array; for FLITECAM, an average value of f=0.5 is used 
for all pixels.  Using this pedestal estimate, the signal for an individual readout is estimated as: 

𝑠()) = +!"!		
.#.$

+ 𝑝())  
and both pedestal and signal are corrected for nonlinearity.  In order to account for the pedestal 
value of the flats used to determine the linearity coefficients, the coefficients are normalized by 
the first coefficient plane, and the polynomial is applied to the value to correct, minus the flat 
pedestal: 

𝑝(1) = 𝑝()) 2%
2&'34())54+',!6

  

𝑠(1) = 𝑠()) 2%
2&'37())54+',!6

, 

where Cnl is the full correction polynomial for each pixel in the image.  This process is then 
repeated once more, replacing Stot with  

𝑆&8&(1) = 𝑛9𝑛:𝑠(1) − 𝑛9𝑛:𝑝(1) . 
The final value for Stot, calculated from s(3) and p(3), is the linearity corrected image. 
 
After linearity correction, the variance is calculated for each pixel from: 

𝑉 = +!"!
;	.#	.$-/&-

B1 − -&3.#-5)6
<	/&	.#

D + 1	=#-

;-	.#.$	/&-
, 

where g is the electronic gain and σr is the read noise for the detector (Vacca et al., 2004).  This 
variance is propagated through all remaining reduction steps and its square root (the uncertainty) 
is recorded in all output files along with the image, as a separate plane in the data array. 
 
For the imaging pipeline, before proceeding, the linearity-corrected images and the 
corresponding uncertainty planes are typically clipped to the size of the useful part of the 
detector (the cyan box in Figure 1). 
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3.2.2 Dark correction 
The imaging pipeline provides, as an optional step, a method to combine dark frames and 
subtract them from individual science frames.  This is intended to correct for any dark current in 
the detector.  However, FLITECAM’s dark current has been shown to be negligibly small, and in 
the course of normal reductions, the median dark current is automatically subtracted off along 
with the background level in the sky subtraction step anyway.  Therefore, dark correction is not 
usually used. 
 
If dark frames are provided, they are scaled to the exposure time of the science observation and 
averaged together before being subtracted from the science frames. 

3.2.3 Gain correction 
As with all modern near-IR detectors, raw images produced by FLITECAM are afflicted with 
hot and cold pixels, and significant pixel-to-pixel gain variations.  In addition, FLITECAM’s 
detector has a large region of low quantum efficiency in the third quadrant and the top of the 
fourth quadrant of the detector, as shown in Figure 1. These gain variations can be corrected by 
dividing by a normalized flat field image. 
 
Imaging flats for FLITECAM are made from images of the sky.  In the nod-off-array mode, 
dithered sky images are used to generate the flat.  In the stare mode, the dithered source images 
themselves are used to generate the flat.  In either case, the algorithm to generate the flat is the 
same 
 
First, bad pixels are identified in each frame and recorded in a set of bad pixel masks.  Then, all 
images are combined into a “draft” flat with a high-low rejection algorithm.  The draft flat is 
used to flat-correct all input images, and each image has its median value subtracted off, as a 
quick background subtraction.  These draft images are then used to create object masks that 
identify any point sources in the frame; the object mask is then added to the bad pixel mask.  The 
raw images are then re-combined, ignoring any pixels identified in the bad pixel/object mask for 
each frame. 
 
When the final flat frame has been created, it is divided by its median value to normalize it, then 
it is divided into all input source images to correct for gain variations. 
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3.2.4 Sky subtraction 
The sky background level must then be subtracted for each image.  For imaging frames, since the 
flat is made from the sky images, the average sky level can be found by taking the median of the 
unnormalized flat.  This sky level is subtracted from each source image.  Optionally, the median 
value of each individual image can be subtracted, in place of the median level from the flat. 

3.2.5 Image Registration and Coaddition 
In order to coadd dithered images, the images must be shifted into a common grid, so that the 
sources appear at the same location on the array.  FDRP has several methods available to 
determine the offsets required to shift each image to the reference frame of the first image: 

Figure 5: Top left: raw frame at a single dither position, in stare mode.  Top right: flat 
frame made from all dither positions. Bottom: Gain corrected image. 
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• Read the dither parameters from the header of the files.  The executed offsets should be 
recorded in the DITHERX and DITHERY keywords.  This method is limited by the 
accuracy of the values recorded in the header. 

• Compute the cross-correlation of the first frame with each subsequent frame, and use the 
results to calculate the offsets.  This method can take a significant amount of time to 
complete. 

• Compute the centroid of the brightest source in each image, and use the positions to 
calculate the offsets.  This method may not be reliable if there is not a bright point source 
common to all frames. 

• Compute the offsets interactively, allowing the user to select a common point in each 
frame. 

• Allow the user to directly specify the required offsets, computed separately. 
The default option is to use the header keywords if they are available, and the cross-correlation if 
they are not.  It is also possible for the user to specify that registration and coaddition are not 
desired, and should be skipped. 
 
After the offsets have been determined, they are applied to each image as an integer pixel shift.  
By default, no interpolation is performed.  Then, all input images are combined with a robust 
weighted mean algorithm, which helps to mitigate bad pixels in the final output. 

3.2.6 Flux calibration 
For imaging observations, flux calibration factors are typically calculated from all standards 
observed within a flight series, as detailed in the flux calibration section, below.  These 
calibration factors are recorded in the headers of all coadded products, then, as a final step in the 
pipeline, are used to produce a flux-calibrated image.  The final Level 3 product has image units 
of Jy.1 
 

3.3 Spectroscopy Reduction algorithms 

The following subsections detail each of the data reduction pipeline steps outlined in the grism 
flowchart above.  All algorithms in this section are carried out by the FSpextool package.  This 
section borrows heavily from the Spextool paper; see the Other Resources section, below, for a 
reference to this paper. 

3.3.1 Flat Field Processing 
FSpextool’s first step in reducing spectroscopic frames is to prepare a master flat frame.  In order 
to get a high signal-to-noise ratio in this processed flat field, it is typical to take multiple flat-
field exposures and combine them together.  If there is a significant dark current, it may also be 
beneficial to take a number of dark frames, combine them together using a median statistic, and 
subtract the result from the individual flat frames.  After dark subtraction, if necessary, 
FSpextool calculates the median signal of each frame and scales them all to a common level (the 

 
 
1 Note that earlier versions of this pipeline did not produce a final calibrated file.  The final Level 
3 products had image units of DN/sec, with the flux calibration factor (DN/sec/Jy) recorded in 
the FITS header keyword, CALFCTR.  
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median of the individual median levels).  It then combines all the flats, typically using a median 
statistic. 
 
FSpextool then uses this master flat to determine the edges of the spectral order on the detector.  
It draws an approximate center position for the order from a configuration file on disk.  Starting 
from this position, it uses an edge detection algorithm to find the top and bottom of the order at 
regular intervals across the dispersion direction.  The edge points are then fit with a low-order 
polynomial to give the edge coefficients of the order.  These coefficients are later used in the 
source extraction process to reconstruct the location of the order at any given column. 
 
Finally, the flat field is normalized to unity so that when it is divided into the source spectrum, it 
does not affect the signal-to-noise estimate for the spectrum.  In order to correct for the spectral 
shape of the flat source, the normalization begins by fitting a low-order two-dimensional surface 
to a straightened, resampled flat image.  This fit is then divided into the unresampled master flat 
to normalize it. 
 
FSpextool also calculates the variance of the master flat frame.  The variances of the input flat 
and dark frames depend on the RMS read noise of the detector, the detector gain, the integration 
time per coadd, and the number of counts in each pixel.  The variance for the master flat is the 
combination of the variances of all the input frames, propagated through dark subtraction, 
scaling, median-combination, and the normalization process. 
 
For some observations, there may not be appropriate flat fields available.  In this case, FSpextool 
provides a default flat for each grism mode that defines the edges of the spectral order, but 
should not be divided into the data.  This will allows processing to continue through extraction.  
The flux calibration procedure can then be used to correct for instrumental response variations, 
after extraction. 

3.3.2 Image Processing 
As for the FLITECAM imaging mode, FSpextool first corrects the input images for detector 
nonlinearity and creates a variance plane, using the algorithm described above.   Then, the 
pipeline does A-B pair subtraction of all the input images.  It then converts the units in the image 
from raw counts to counts per second by dividing by the integration time per coadd (Δt).  It also 
divides by the normalized flat, if available.  The resulting signal in the 2-D spectrum is: 

S!" =
>.->/
∆A∙CDEA

  
where SA is the raw counts in frame A, SB is the raw counts in frame B, and flat is the normalized 
flat image. 
 
Alongside the image processing, the individual variances for the A frame, B frame, and flat are 
combined as follows to get the total variance for the 2-D spectrum: 

V!" =
F.0F/
∆A-∙CDEA-

+ F0123∙>./
-

CDEA-
  

where VA is the variance of frame A, VB is the variance of frame B, and Vflat is the variance of the 
normalized flat image. 
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Figure 6: Pair-subtracted image in nod-on-slit mode, rotated to align the 
dispersion axis with the x-axis. 
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3.3.3 Spatial Profile Construction 
In order to aid in spectral extraction, FSpextool constructs a smoothed model of the relative 
intensity of the target spectrum at each spatial position, for each wavelength.  This spatial profile 
is used to compute the weights in optimal extraction or to fix bad pixels in standard extraction 
(see below).  Also, the user must refer to the median profile, collapsed along the wavelength 
axis, to define the extraction parameters.  Since FSpextool rotates input data so that dispersion is 
along the x-axis, we will here refer to a wavelength point as a column, and a spatial point as a 
row. 
 
To construct the spatial profile, FSpextool first subtracts the median signal from each column in 
a spectral order to remove the residual background. It then resamples the order onto a regular 
grid of wavelength columns and spatial rows; this has the effect of removing any curvature of the 
order across the detector.  The intensity in this resampled image in column i and row s is given 
by 

OG,I = fGPG,I  
where fi is the total intensity of the spectrum at wavelength i, and Pi,s is the spatial profile at 
column i and row s.  To get the spatial profile Pi,s, we must approximate the intensity fi.  To do 
so, FSpextool computes a median of the columns of the order image to get a first-order 
approximation of the median spatial profile Ps.  Assuming that  

OG,I ≈ cGPI, 
FSpextool uses a linear least-squares algorithm to fit Ps to Oi,s and thereby determine the 
coefficients ci.  These coefficients are then used as the first-order approximation to fi: the 
resampled order image Oi,s is divided by fi to derive Pi,s.   FSpextool then fits a low-order 
polynomial along the columns at each spatial point s in order to smooth the profile and thereby 
increase its signal-to-noise.  The coefficients of these fits can then be used to determine the value 
of Pi,s at any column i and spatial point s (see Figure 7, left).  The median of Pi,s along the 
wavelength axis generates the median spatial profile, Ps (see Figure 7, right).  Finally, Pi,s is 
resampled back onto the pixel grid (i,j) to derive a profile Pi,j that matches the  coordinates of the 
raw image. 
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3.3.4 Aperture Location and Tracing 
The median spatial profile can now be used to identify extraction apertures for the target.  The 
aperture centers can be identified automatically by iteratively finding local maxima in the 
absolute value of the spatial profile, or can be specified directly by the user. 
 
The true position of the aperture center will, however, vary somewhat with wavelength, as a 
result of small optical effects or atmospheric dispersion.  To account for this variation, FSpextool 
traces the spectrum across the array.  For a point source, it fits a Gaussian in the spatial direction, 
centered at the specified position, at regular intervals in wavelength.  The centers of these fits are 
themselves fitted with a low-order polynomial; the coefficients of these fits give the trace 
coefficients that identify the center of the spectral aperture at each wavelength.  For an extended 
source, the continuum cannot generally be directly traced.  Instead, FSpextool uses the edges of 
the order to find the pixel position of the user-specified aperture center at each wavelength, and 
fits these positions with a low-order polynomial to get the trace coefficients. 
 
Besides the aperture centers, FSpextool also requires that the user specify a few more aperture 
parameters.  For point sources, optimal extraction requires a PSF radius, corresponding to the 
distance from the center at which the flux from the source falls to zero.  For all extractions (point 
source or extended source, optimal or standard), FSpextool requires an aperture radius, 
corresponding to the edge of the extraction aperture.  It is also possible to specify a background 
region outside of any extraction apertures, for fitting and removing the residual sky signal. 
 
 

Figure 7: Spatial profile image as a function of wavelength and slit 
position (left), and median spatial profile as a function of slit position 

(right) 
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3.3.5 Spectral Extraction 
Before extracting a spectrum, FSpextool first uses the identified background regions to find the 
residual sky background level.  For each column, it fits a low-order polynomial to the values in 
the specified regions, as a function of slit position.  This polynomial determines the wavelength-
dependent sky level (Ri,j) to be subtracted from the spectrum (Di,j). 
 
FSpextool offers two methods for extracting a spectrum from the sky-subtracted image: optimal 
and standard extraction.  The standard extraction method uses values from the spatial profile 
image (Pi,j) to replace bad pixels and outliers, then sums the flux from all pixels contained within 
the aperture radius.  The flux and variance at column i is then: 

fGIJK = ∑ ϵG,LMDG,L-RG,LP
L-
LML)  

VGIJK = ∑ ϵG,L1 :VN4,6 + VO4,6=
L-
LML)   

where j1 and j2 are the upper and lower limits of the extraction aperture (in pixels), and εi,j is the 
fraction of the pixel (i, j) that is contained within the extraction aperture.  This extraction method 
is the only algorithm available for extended sources. 
 
Point sources may occasionally benefit from using standard extraction, but optimal extraction 
generally produces higher signal-to-noise ratios for these targets.  This method works by 
weighting each pixel in the extraction aperture by how much of the target’s flux it contains.  
FSpextool first normalizes the spatial profile by the sum of the spatial profile within the PSF 
radius defined by the user: 

PG,L' =
Q4,6

∑ Q4,7
7-
7)

  

where k1 and k2 are the upper and lower limits given by the PSF radius. P’
i,j now represents the 

fraction of the total flux from the target that is contained within pixel (i,j), so that (Di,j –Ri,j)/ P’
i,j 

is a set of j independent estimates of the total flux at column i.  FSpextool does a weighted 
average of these estimates, where the weight depends on the pixel’s variance (VDij + VRij), as well 
as the normalized spatial profile (P’

i,j ).  Then the flux and variance at column i is: 

 fG
STA =

∑ U4,6Q4,6(N4,6-OV4,6)/(F84,60F9:4,6)
6-
6)

∑ U4,6Q4,6-/(F84,60F9:4,6)
6-
6)

			   

VG
STA = )

∑ U4,6Q4,6-/(F84,60F9:4,6)
6-
6)

  

where MG,L is a bad pixel mask and j1 and j2 are the upper and lower limits given by the aperture 
radius.  Note that bad pixels are simply ignored, and outliers will have little effect on the average 
because of the weighting scheme. 
 
After extraction, spectra from separate apertures or separate images may be combined together to 
increase the signal-to-noise of the final product.  The default combination statistic is a robust 
weighted mean.   

3.3.6 Wavelength Calibration 
FSpextool can extract spectra from images where the dispersion axis is well aligned with the 
image rows. In this case, each column represents a single wavelength bin.  The wavelength 
calibration is one-dimensional, and can be derived from an extracted spectrum of an arc lamp or 
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sky lines.  FSpextool can also extract spectra from images where the dispersion axis does not 
align with the image rows: that is, there may be a significant curvature or tilt to the spectral lines 
with respect to the columns.  In this case, the wavelength calibration must be two-dimensional, 
and can be derived from a two-dimensional spectral image of an arc or sky lines.  FSpextool 
provides an interactive GUI, called xwavecal2d, which allows the user to identify spectral lines 
at regular intervals across the image, fit a surface to the wavelength and spatial data, and produce 
a map of the wavelength and spatial coordinates at each pixel. 
 
Two-dimensional wavelength calibration requires an extra step in the extraction process, in order 
to ensure that each pixel contains only data from a single wavelength bin.  FSpextool 
accomplishes this by first interpolating the x and y image coordinates onto a regularized grid of 
wavelength and spatial coordinates, as read from the wavelength calibration map.  For each 
wavelength bin in this grid, it steps through the spatial elements, adding up the flux of any pixel 
or partial pixel contained within the given spatial and wavelength bin (the shaded area in the 
figure below).  The resultant sums construct the flux profile with respect to the spatial 
coordinate, analogous to a slice along a column in the case of one-dimensional wavelength 
calibration.  This profile is then used to perform either standard or optimal extraction as detailed 
above. 
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Commissioning data appears to show that FLITECAM spectral lines have significant curvature 
or tilt with respect to array columns, particularly for the narrow slit.  Therefore, two-dimensional 
wavelength calibration maps are required to correctly extract and calibrate the spectra.  However, 
it is not expected that wavelength calibration will change significantly between observations.  
Therefore, FSpextool provides a default wavelength calibration map for each grism mode that 
can be used to extract FLITECAM data.  The xwavecal2d GUI can be used to produce new maps 
as needed.   
 
The default wavelength calibration is expected to be good to within one pixel of dispersion, 
provided that the grisms have not shifted since the wavecal maps were made.  As a final step, the 
pipeline offers the user the chance to identify spectral features in the extracted spectrum.  Using 
these features, the pipeline calculates a zero-point shift to apply to the wavelengths after 
extraction.  This step can correct for any minor shifts in the wavelength calibration. 

Figure 8: Extraction with two-dimensional wavelength calibration.  The flux for the 
pixel at spatial element k and wavelength j is the weighted sum of the flux from pixels 

contained, or partially contained, within the grid element. 
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3.3.7 Flux calibration 
For spectroscopic observations of stellar standards, instead of applying a flux calibration, the 
pipeline divides the extracted spectra by an atmospheric transmission model and a stellar model, 
in order to produce an instrumental response curve that can be used to calibrate science 
observations.  This response curve is the final pipeline output for stellar standards. 
 
For observations of science targets, the final extracted spectrum is corrected for atmospheric 
transmission and instrumental response, as derived from the aforementioned stellar standard 
observations, producing a flux-calibrated spectrum in units of Jy.  See the section on flux 
calibration, below, for more detailed information. 
 
 
 
3.3.8 Combining spectra 

Figure 9: Final extracted, calibrated spectrum. 
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After flux calibration, individual spectra from separate nod-pairs and/or separate apertures are 
combined to produce a single coadded spectrum.  Typically, all spectra are scaled to a median 
value before combining, and are then combined with a robust weighted mean algorithm. 
 
It may sometimes be useful to stitch together separate spectra in order to view the entire 
wavelength coverage of an observation in a single plot.  FSpextool provides a tool called 
xmergeorders to perform this task.  This tool can, for example, combine extracted spectra from 
several different grism modes, using any overlapping regions to scale the spectra to each other. 

3.4 Other Resources 

For more information on the instrument itself, see the FLITECAM paper: 
FLITECAM: a 1-5 micron camera and spectrometer for SOFIA, Ian S. McLean, et al. 

(2006, SPIE 6269E, 168). 
or the SOFIA observer’s handbook: 

Sofia Observer's Handbook for Cycle 2: v2.1.2, SOFIA User Support Group (2013, 
SOFIA Science Center). 

 
For more information about the Redux, FDRP, PipeCal, and FSpextool software architecture, see 
the Redux Developer’s Manual, located in redux/helpfiles. 
 
For more information on how to run the FSpextool interactive tools (xspextool, ximgtool, xvspec, 
xwavecal2d, xcombspec, xtellcor_general, and xcleanspec), see the help files distributed with the 
FSpextool code, under fspextool/Helpfiles. 
 
For more information on the reduction algorithms used in FSpextool, see the Spextool papers:  

Spextool: A Spectral Extraction Package for SpeX, a 0.8-5.5 Micron Cross-Dispersed 
Spectrograph, Michael C. Cushing, William D. Vacca and John T. Rayner  
(2004, PASP 116, 362). 

A Method of Correcting Near-Infrared Spectra for Telluric Absorption, William D. 
Vacca, Michael C. Cushing and John T. Rayner (2003, PASP 115, 389). 

Nonlinearity Corrections and Statistical Uncertainties Associated with Near-Infrared 
Arrays, William D. Vacca, Michael C. Cushing and John T. Rayner  (2004, 
PASP 116, 352). 

 
For more information on the IDL Astronomy User’s Library, used in both the imaging and grism 
pipelines, see: 

The IDL Astronomy User's Library, W.B. Landsman (1995, ASPC 77, 437). 
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4 FLUX CALIBRATION 

4.1 Imaging Flux Calibration 

The reduction process, up through image coaddition, generates Level 2 images with data values 
in units of digital number per second (DN/sec). After Level 2 imaging products are generated, 
the pipeline derives the flux calibration factors (in units of DN/sec/Jy) and applies them to each 
image. The calibration factors are derived for each FLITECAM filter configuration from 
observations of calibrator stars. 
 
After the calibration factors have been computed, they are written to the headers of the Level 2 
coadded files in the FITS keyword CALFCTR. The coadded file is then divided by this factor to 
produce the Level 3 data, in units of Jy.  
 

4.1.1 Reduction steps 
The calibration is carried out in several steps. The first step consists of measuring the photometry 
of all the standard stars for a specific mission or flight series. Calibration factors are then derived 
from the measured photometry and the known fluxes of the standards. For each object, the 
calibration factors from all the standards on a flight are adjusted to account for the differences 
between the target airmass and altitude and those of the standards, and then averaged. The 
pipeline then inserts this value and its uncertainty into the headers of the Level 2 data files for the 
flux standards. After all calibration factors are derived for a flight series, the final step requires 
studying the calibration values, ensuring that the values are consistent. Outlier values may come 
from bad observations of a standard star; these values are removed to produce a robust average 
of the calibration factor across the flight series. 
 
The determination of the calibration factors begins with the analysis of the reduced Level 2 
images of the standard stars observed on a given flight.  The pipeline performs aperture 
photometry on these images after the registration stage.  This measured count rate is then divided 
by the predicted flux in Jy for each star in each filter.  These predicted fluxes were computed by 
multiplying the model stellar spectrum by estimates for the overall filter + instrument + telescope 
+ atmosphere response curve and integrating over the filter passband to compute the mean flux 
in the band. The adopted filter throughput curves are those provided by the vendor. The 
instrument throughput is calculated by multiplying an estimate of the instrumental optics 
transmission (0.80) and the detector quantum efficiency (0.56). The FLITECAM overall 
throughput is (0.285). The telescope throughput value is assumed to be constant (0.85) across the 
entire FLITECAM wavelength range. The atmospheric transmission is computed using the 
ATRAN code (Lord 1992) for a range of observatory altitudes (corresponding to a range of 
overhead precipitable water vapor values) and telescope elevations. The equations used for 
determining the mean wavelength and the mean flux of the standard at the mean wavelength are 
given in Tokunaga & Vacca (2005). The equations for deriving the flux for a flat spectrum 
source are the same as those given in Herter et al. (2013) for FORCAST. 
 
Photometric standards for FLITECAM have been chosen from three sources: (1) bright stars 
with spectral classifications of A0V as listed in SIMBAD; (2) Landolt SA stars (K giants and 
A0-4 main sequence stars) listed as 'supertemplate' stars in Cohen et al. (2003); K giant stars 
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listed as 'spectral template' stars in Cohen et al. (1999). For all of these objects, models are either 
available (from the Cohen papers) or derivable (from a model of Vega for the A0V stars). Use of 
the A0V stars requires scaling the Vega model to the observed magnitudes of the target and 
reddening the model to match the observed color excess of the target. It should be noted that 
A0V stars should be used to calibrate the Pa alpha filter, as these objects have a strong 
absorption feature in this band. The models of the spectral template K giants listed  
in  Cohen et al. (1999) extend down only to 1.2 microns, and therefore cannot be used to 
calibrate the J band filter.  
 
Using the measured photometry of the standard, 𝑁X7&Y (in counts/s), and the predicted mean 
fluxes of the standards in each filter,  〈𝐹Z7&Y〉	(in Jy), the flux of a target object is 

𝐹Z.8[,8\]M𝜆:X#P =
^;
"<=

2
  

where 𝑁X
8\]is the count rate in counts/s detected from the source, 𝐶 is the calibration factor 

(counts/s/Jy), and 𝐹Z.8[,8\](𝜆_𝑟𝑒𝑓	) is the flux in Jy of a nominal, “flat spectrum” source (for 
which ) at a reference wavelength 𝜆:X#. The calibration factor, 𝐶, is computed from  

 
with an uncertainty given by  

Here, 𝜆4_`is the pivot wavelength of the filter, 〈𝜆〉 is the mean wavelength of the filter, and the 
ratio  accounts for differences in system response (transmission) between the actual 
observations and those for a ‘reference’ altitude of 41K and a telescope elevation of 45°. 
 
The values of C, sC , and lref are written into the headers of the Level 3 data as the keywords 
CALFCTR, ERRCALF, and LAMREF, respectively. The reference wavelength 𝜆:X#	for these 
observations was taken to be the mean wavelengths of the filters, 〈𝜆〉. Note that sC currently 

assumes no uncertainty on the stellar models and the values of . Typical uncertainties on 
the NIR stellar model fluxes are expected to be on the order of 3-6%. 
 
Each observation of a standard provided a value of the calibration factor in the various filters. 
The values of C were examined across all of the Cycle 1 flights to check for consistency. 
Discrepant values signaled problems with the standard star data and those images were then 
excluded from the calibration process. 
 

4.1.2 Color corrections 
An observer often wishes to determine the true flux of an object at the reference wavelength, 
𝐹Z
8\]M𝜆:X#P, rather than the flux of an equivalent nominal, “flat spectrum” source. To do this, we 

define a color correction K such that 
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𝐾 =	 a>
&"?,"<=3b#;+6

a>
"<=3b#;+6

,  

where 𝐹Z
.8[,8\]M𝜆:X#P is the flux density one obtained by measurement on a data product. Divide 

the measured values by K to obtain the “true” flux density. In terms of the wavelengths defined 
above,  

𝐾 =	
〈b〉b#;+	
bABC
-

〈a>
"<=〉

a>
"<=3b#;+6

.  

For most filters and spectral shapes, the color corrections are small (<10%). Tables listing K 
values and filter wavelengths are available from the SOFIA website. 
 

4.2 Spectrophotometric Flux Calibration 

The common approach to characterizing atmospheric transmission for ground-based infrared 
spectroscopy is to obtain, for every science target, similar observations of a spectroscopic 
standard source with as close a match as possible in both airmass and time. Such an approach is 
not practical for airborne observations, as it imposes too heavy a burden on flight planning and 
lowers the efficiency of science observations. Therefore, we employ a calibration plan that 
incorporates a few observations of calibration stars per flight and models of the atmospheric 
absorption for the approximate altitude and airmass at which the calibration stars and science 
objects were observed. Telluric absorption models have been computed, using ATRAN, for the 
entire set of FLITECAM grism passbands for every 1000 feet of altitude between 35K and 44K 
feet, and for every 5 degrees of zenith angle between 30 and 70 degrees. These values 
correspond to the typical observing limits of SOFIA.  
 
Instrumental response curves for each grism and slit combination may be generated from 
observations of A0V stars and stellar models constructed from a model of Vega.  The pipeline 
automatically generates these raw response curves from standard star observations. The stellar 
spectra are corrected for telluric absorption by (1) identifying the ATRAN model closest in 
altitude and airmass to the values for the observation, (2)  smoothing the model to the resolution 
of the observed data (which depends on the slit width used), (3) re-binning the smoothed model 
to the observed sampling of the data, and finally (4) dividing the observed spectrum by the 
smoothed, re-sampled model. The telluric corrected spectrum is then divided by a stellar spectral 
model which has been constructed by (1) smoothing and resampling a high resolution model of 
Vega to the observed resolution and bin sizes, (2) scaling the model to match the brightness of 
the observed A0V star in a given passband (usually V) as listed in a catalog, (3) reddening the 
model in order to match the colors of the observed star as listed in a catalog, and (4) convolving 
with a broadening function to account for the measured rotation of the observed star (if known). 
The division of the telluric corrected observed spectrum by the resulting model spectrum yields 
the response curve. These response curves can be inspected, combined, and smoothed to generate 
more robust response functions to apply to all observations within a mission or a flight series.  
 
Flux calibration of FLITECAM grism data for a science target is currently carried out in a two-
step process: 

1. For any given observation of a science target, the closest telluric model (in terms of 
altitude and airmass of the target observations) is selected and then smoothed to the 
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observed resolution and sampled at the observed spectral binning. The observed spectrum 
is then divided by the smoothed and re-sampled telluric model. 

2. The telluric-corrected spectrum is then divided by a response function corresponding to 
the observed instrument mode to convert DN/s to Jy at each pixel. 

 
In order to account for any wavelength shifts between the models and the observations, an 
optimal shift is estimated from the peak of the cross-correlation of the observed spectrum and the 
correction curves. At each step the observed spectrum is shifted by the calculated amount, then is 
divided by the correction curve.  
 
Based on our experience with FORCAST calibration, and with using A0V stars to calibrate near-
infrared data, we expect the overall error in the flux calibration to be about 20%. However, the 
uncertainty on the slope of the calibrated spectrum should be substantially less than that, on the 
order of a few percent (see e.g., Cushing et al. 2005; Rayner et al. 2009). The Level 3 data 
product for any grism includes the calibrated spectrum and an error spectrum that incorporates 
this expected uncertainty. The adopted telluric absorption model and the instrumental response 
functions are also provided in the output product.  
 
As for any slit spectrograph, highly accurate absolute flux levels from FLITECAM grism 
observations (for absolute spectrophotometry, for example) require additional photometric 
observations to correct the calibrated spectra for slit losses that can be variable (due to varying 
image quality) between the spectroscopic observations of the science target and the calibration 
standard. 

5 DATA PRODUCTS 

5.1.1 Filenames 
FLITECAM output files from Redux are named according to the convention: 
FILENAME = F[flight]_FC_IMA|GRI_AOR-ID_SPECTEL1SPECTEL2_Type_FN1[-FN2].fits,  
where flight is the SOFIA flight number, FC is the instrument identifier, IMA or GRI specifies 
that it is an imaging or grism file, AOR-ID is the 8 digit AOR identifier for the observation, 
SPECTEL1 and SPECTEL2 are the keywords specifying the filter, grism, or slit used, Type is 
three letters identifying the product type (listed in the table below), and FN1 is the file number 
corresponding to the input file.  FN1-FN2 is used if there are multiple input files for a single 
output file, where FN1 is the file number of the first input file and FN2 is the file number of the 
last input file. 

5.1.2 Pipeline Products 
The following table lists all intermediate products generated by Redux for FLITECAM, in the 
order in which they are produced. The product type is stored in the FITS headers under the 
keyword PRODTYPE.  By default, for imaging, only the final coadded and calibrated products 
are saved.  For spectroscopy, the image, flat, rectified image, calibrated spectra, and final 
combined spectrum are saved by default.  Specifying the appropriate option in either the 
automatic or interactive modes will save all products. 
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Mode Description PRODTY
PE 

ID Saved 
by 

default? 
Imaging Non-linearity corrected  lincor LIN N 
Imaging Clipped to usable portion of detector clipped CLP N 
Imaging Bad pixel masks bpmsk BPM N 
Imaging Initial (draft) flat field flat_draft DFL N 
Imaging Initial (draft) flat fielded images ffimg_draft DFF N 
Imaging Flat-fielded with DFL and sky subtracted ffsub_draft DFS N 
Imaging Object plus bad pixel masks obmsk OBM N 
Imaging Final flat/sky image sky SKY N 
Imaging Final normalized flat field flat FLT N 
Imaging Flat fielded images ffimg FFI N 
Imaging Flat-fielded and sky subtracted ffbsub FBS N 
Imaging Registered images imreg RIM N 
Imaging Coadded image coadd COA Y 
Imaging Calibrated image calibrated CAL Y 
Grism Linearized, flat-corrected, pair-subtracted 2D 

spectrum 
image 

 
IMG Y 

Grism Normalized flat field flat FLT Y 
Grism Rectified image (produced during extraction) rectimg RIM Y 
Grism Extracted spectra, containing all apertures spec SPC N 
Grism Calibrated spectra, containing all apertures calspec CAL Y 
Grism Instrumental response curves (generated for 

standard stars only) 
rspspec RSP Y 

Grism Combined spectrum from all images combspec CMB Y 
 

Table 1: Final and intermediate data products 
 
5.1.3 Data Format 
All files produced by the pipeline are FITS single-extension image files.  All image products (for 
both imaging and spectroscopy modes) are 3-D arrays of data, where the first plane is the image 
frame and the second plane represents the uncertainty associated with each pixel in the image.  
For imaging products, the uncertainty plane is the 1-sigma uncertainty; for grism images, the 
plane contains the variance (the square of the 1-sigma uncertainty).  The final coadded image for 
the imaging pipeline and the rectified image for the spectroscopy pipeline also have a bad pixel 
mask appended in a third plane.  The fourth plane in the coadded image is an exposure map, 
indicating the number of exposures at each pixel; multiply this frame by the value of the 
keyword INTTIME to get the total integration time at each pixel.  The extracted spectral 
products are one-dimensional spectra, stored in four rows of data.  The first row is the 
wavelength, the second is the flux, the third is the error (standard deviation), and the fourth is a 
reference atmospheric transmission model.  If there were multiple apertures selected (e.g. for the 
nod-on-slit mode), then the spectrum for each aperture is stacked into a different plane.  The 
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length of the row varies depending on the data, but is typically around 1000 pixels.  For the 
calibrated and combined spectra, a fifth row is added for reference, containing the instrumental 
response curve applied, in DN/sec/Jy. 

6 GROUPING LEVEL_1 DATA FOR PROCESSING 

For FLITECAM’s imaging mode, there are three kinds of input data: darks, sky frames, and 
sources.  Darks are always optional. The sky frames and source frames should share the same 
exposure time and number of hardware coadds, as well as instrument configuration and filters.  
In order to be calibrated together, they must also be taken at similar altitudes and zenith angles.  
It may also be necessary to require that they are taken on the same flight leg, or with the same 
line-of-sight rewind. 
 
For the grism mode, there are darks, flats, and sources.  Darks are optional, but if used, they 
should match the exposure time and number of coadds of the flats.  Flat frames are 
recommended, but may be replaced with default flats if appropriate frames were not taken with 
the science.  If provided, flat frames should match the filter, grism, and slit of the source 
observation.  All source observations must share the same target, filter, grism, slit, exposure 
time, and coadds, and must be taken at similar altitudes and zenith angles. 
 
These grouping requirements translate into a set of FITS keywords that must match in order for a 
set of data to be grouped together.  These relationships are summarized in the figures and tables 
below. 
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Keyword Datatype Match Criterion 
OBSTYPE STR Exact 
OBJECT STR Exact 
INSTCFG STR Exact 

SPECTEL1 STR Exact 
EXPTIME FLT Exact 
COADDS INT Exact 
MISSN-ID STR Exact 
ALTI_STA FLT +/- 500 
ALTI_END FLT +/- 500  
ZA_START FLT +/- 2.5 

ZA_END FLT +/- 2.5 
PLANID STR Exact 

AOR_ID (optional) STR Exact 
LASTREW (optional) STR (DATE/TIME) Exact 

Table 2: Grouping criteria for FLITECAM imaging 

 
  

Figure 10: Grouping keyword requirements for FLITECAM imaging mode 
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Keyword Datatype Match Criterion 
OBSTYPE STR Exact 
OBJECT STR Exact 
INSTCFG STR Exact 

SPECTEL1 STR Exact 
SPECTEL2** STR Exact 

EXPTIME FLT Exact 
COADDS INT Exact 
MISSN-ID STR Exact 
ALTI_STA FLT +/- 500 
ALTI_END FLT +/- 500 
ZA_START FLT +/- 2.5 

ZA_END FLT +/- 2.5 
PLANID STR Exact 

AOR_ID (optional) STR Exact 
LASTREW (optional) STR (DATE/TIME) Exact 

Table 3: Grouping criteria for FLITECAM grism.  **If SPECTEL2 is in use (value!='NONE' 
or 'UNKNOWN'), the observation should always be included in the grism plan, regardless 

of INSTCFG. 

 

Figure 11: Grouping keyword requirements for FLITECAM grism mode 
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7 CONFIGURATION AND EXECUTION 

7.1 Installation 

Redux with FDRP and FSpextool was developed under Linux and MacOS X operating systems.  
Other operating systems may also work, but have not been tested.  Running Redux requires IDL 
8.1 or later, as well as the latest version of the IDL Astronomy User’s Library, the Coyote 
graphics library, the FDRP package, the FSpextool package, the PipeCal package, and the Redux 
code.  FDRP, FSpextool, PipeCal, and Redux are under SOFIA DPS revision control and can be 
obtained directly from git repositories there.  The IDL Astronomy User’s Library (astrolib) is 
publicly available, and can be downloaded from the website at the following URL:  

http://idlastro.gsfc.nasa.gov/homepage.html.  
The Coyote graphics library (coyote) is also publicly available and can be downloaded from: 

http://www.idlcoyote.com/documents/programs.php. 
When these packages have been installed, their locations should be added to the IDL_PATH 
environment variable, so that their procedures are accessible to Redux. 
 
SOFIA may distribute the Redux, FDRP, PipeCal, and FSpextool packages as gzipped tar files.  
If so, unpack them, as, for example: 

tar xvzf redux.tar.gz 
tar xvzf fdrp.tar.gz 
tar xvzf pipecal.tar.gz 
tar xvzf fspextool.tar.gz 

This will create directories called redux, fdrp, pipecal, and fspextool, which will contain a 
number of subdirectories.  Each of these package directories should be added to the IDL_PATH 
as well. 
 

7.2 Configuration 

For FSpextool algorithms, default options are specified in a configuration file called 
FLITECAM.dat, located in the fspextool package directory.  This file contains keyword-value 
pairs, in the format parameter=value. The parameters must all be present and in the correct 
order, but can have any number of spaces or comments between them.  Comment lines begin 
with the % or # character. See Appendix A for a sample of this configuration file.  FDRP does 
not have a configuration file for parameter definition. 
 
Additional default parameter values may be defined by the Redux interface object.  These values, 
as well as the values defined in the FSpextool configuration file, may be overridden manually for 
each reduction step, while running in interactive mode.  They may also be overridden by an input 
parameter file, in JSON format, in either interactive or automatic mode.  See Appendix B for an 
example of an input Redux parameter file; if specified, values in this file override those derived 
from all other configuration files. 
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7.3 Input data 

Redux takes as input raw FLITECAM FITS data files containing 1024x1024 pixel image arrays.  
The FITS headers contain data acquisition and observation parameters and, combined with the 
pipeline configuration files, comprise the information necessary to complete all steps of the data 
reduction process.  Some critical keywords are required to be present in the raw data in order to 
perform a successful grouping, reduction, and ingestion into the SOFIA archive.  These 
keywords are listed in Appendix C. 
 
It is assumed that the input data have been successfully grouped before beginning reduction: 
Redux considers all input files in a reduction to be part of a single homogeneous reduction 
group, to be reduced together with the same parameters. 

7.4 Automatic mode execution 

To run the pipeline from the IDL command line as a DCS black box pipeline, we run the pipeline 
wrapper (redux_pipe.pro).  This wrapper takes as input the path to an input manifest file.  This 
text file should contain a line specifying the number of input files, then the relative path to each 
input file, one per line.  The script then reads these input files, instantiates the appropriate 
reduction object according to the mode specified in the input FITS headers, then calls the 
object’s reduce method.  This method calls each processing step in order, as appropriate for the 
given mode.  Finally, the wrapper script will write an output manifest called outfiles.txt 
containing the names of the produced data files. 
 
This wrapper can be invoked from the IDL prompt, as 

IDL> redux_pipe, ‘infiles.txt’ 
or directly from a terminal as 

localhost$ echo “redux_pipe, ‘infiles.txt’” | idl 
 
The wrapper accepts a single input parameter on the command line, which allows the user to 
give it a parameter file that specifies any desired reduction parameters.  This option is given as, 
for example: 

IDL> redux_pipe,‘infiles.txt’,PARAM_FILE=‘param.json’ 
where param.json is a file that lists parameter keywords and values in JSON format for any step 
in the pipeline reduction (see Appendix B).  Parameter files can be generated interactively with 
the GUI (see below), then saved and fed to the automatic pipeline for batch reduction of a large 
number of files. 

7.5 Manual mode execution 

It is also possible to run the pipeline interactively, using a graphical user interface.  The IDL 
command redux, called without arguments, will launch the Redux GUI. 
 

7.5.1 Basic workflow 
To start an interactive reduction, open a set of FLITECAM files, using the File menu (File -> 
Open New Reduction).  This will bring up a file dialog window (see figure, below).  All files 
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selected will be reduced together as a single reduction set.  If flats or darks are available for the 
reduction, they should be selected along with the source files. 
 

 
Figure 12: Open New Reduction 

 
 
Redux will decide the appropriate reduction steps from the input files, and load them into the 
GUI, as in the figures below.   
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Figure 13: Sample reduction in imaging mode. 



SOF-US-HBK-OP10-2004 
Rev A 

VERIFY THAT THIS IS THE CORRECT REVISION BEFORE USE 
33  

 

 

 
Figure 14: Sample reduction in grism mode. 

 
 
Each reduction step has a number of parameters that can be edited before running the step.  To 
examine or edit these parameters, click the Edit Param button next to the step name to bring up 
the parameter editor for that step. Within the parameter editor, all values may be edited; clicking 
Done will save the edited values and close the window. Clicking Reset will restore any edited 
values to their defaults; clicking Cancel will discard all changes to the parameters and close the 
editor window.  The current set of parameters can be displayed, saved to a file, or reset all at 
once using the Parameters menu.  A previously saved set of parameters can also be restored for 
use with the current reduction (Parameters->Load Parameters).  
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Figure 15: Sample parameter editor (for Register Images step) 

 
After all parameters for a step have been examined and set to the user’s satisfaction, a processing 
step can be run on all loaded files either by clicking Step, or the Run button next to the step 
name. Each processing step must be run in order, but if a processing step is selected in the Step 
to: widget, then clicking Step will treat all steps up through the selected step as a single step.  
When a step has been completed, its buttons will be grayed out and inaccessible.  It is possible to 
undo one previous step by clicking Undo.  All remaining steps can be run at once by clicking 
Reduce. After each step, the results of the processing will be displayed in the display window.  
Clicking Reset will restore the reduction to the initial state, without resetting parameter values. 
 
Files can be added to the reduction step (File->Add Files) or removed from the reduction set 
(File->Remove Files), but either action will reset the reduction for all loaded files.  Selecting 
Display->Display File Information, or the More Info button, will pull up a table of information 
about the currently loaded files (Figure 16). The table rows displayed can be filtered by entering 
a search string into the Filter text box. 
 

 
 

Figure 16: File information table 
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7.5.2 Display features 
Redux displays images using ximgtool, a full-featured display tool distributed with FSpextool.  
For more information, see the ximgtool help file, available from Redux via the Help button just 
above the display.  See the table below for a quick listing of the most useful ximgtool features. 
 
Feature Menu button Keyboard shortcut 
Load new file File->Load FITS -- 
Load file into 
new frame 

File->New Frame -- 

View FITS 
header 

File->View Header -- 

Zoom Zoom->Zoom In, Zoom Out, 
Zoom To Fit 

Press z to enter zoom mode, then i to zoom 
in, o to zoom out, or t to zoom to fit 

Color stretch Cursor->Stretch Press s to enter stretch mode, click and drag 
to change brightness and contrast 

Set display 
range 

Cursor->Range Press r to enter range mode, click and drag 
to select the box that sets the display range 

Display 
distance 

-- Press d to enter distance mode, then click 
and drag to identify start and end points 

Line cut -- Press l to enter line cut mode, then click and 
drag to identify start and end points  

Display image 
statistics 

-- Press m to enter moments mode, then click 
and drag to identify box for which the 
statistics should be calculated 

Photometry -- Press a over a star to do basic photometry. 
Clear current 
mode 

-- Press c 

Buffer select Buffer->Buffer 1, Buffer 2… Press f to move to the next buffer, b to 
move to the previous buffer. 

Buffer math Buffer->Buffer Math, then 
select buffers and arithmetic 
operation to perform 

-- 

Blink buffers Buffer->Blink Buffers -- 
Cycle frames Buffer->Cycle frames Press n to move to the next available frame, 

p to move to the previous frame 
Table 4: Useful ximgtool features 

 
Ximgtool has five buffers available for simultaneous display of images.  If there are more than 
five files loaded into Redux, they can be viewed by selecting Display->Quick Look from the 
Redux menu.  This will cycle through the data in its current processing state, allowing interaction 
and analysis with each image in turn.  To move between images, click the Next File or Previous 
File buttons, below the image.  Click Cancel to quit the quick look display. 
 
In spectroscopy mode, median spatial profiles generated from the 2D spectra are displayed in an 
independent plot window (Figure 17).  When the aperture parameters are set, they will be 
overplot on the spatial profile in this window.   
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Figure 17: Aperture locations identified and overplotted on the spatial profile for a nod-
on-slit observation.  Aperture centers are identified with light blue lines, aperture radius 
with green lines, PSF radius with dark blue lines, and background regions with red lines. 
 
 
Extracted spectra are displayed using xvspec (Figure 18), another display tool packaged with 
FSpextool.  This tool also has a number of useful features (Table 5).  
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Figure 18: Final extracted, calibrated spectrum, displayed in xvspec. 

 
 
 
 
Feature Menu button Keyboard shortcut 
View 
FITS 
header 

File->View Header -- 

View 
select 

View->Flux  for flux data, View-> Uncertainty 
for error on the flux, View-> S/N for signal to 
noise ratio.  If available, View->Transmission 
for transmission spectra and View->Response 
for instrumental response spectra. 

Tab to move to the next view; 
shift-Tab to move to the 
previous view. 

Spectrum 
select 

Spectrum->Select All to select or unselect all 
loaded spectra, or Spectrum->1 to select the first 
spectrum, for example. 

-- 

Set units Units->Wavelength->pixels to display the frame 
number for each data point. 

-- 

Overplot 
reference 
data 

Plot->Overplot->Line List for reference 
wavelengths.  Plot->Overplot->Error Bars to 
show the error spectrum as error bars on the flux.  
Plot->Overplot->Transmission for reference 

-- 
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atmospheric transmission.  Plot->Overplot-
>Response for reference instrumental response.  
Plot->Overplot->Model for reference standard 
model.   

Zoom -- Press z to zoom on both axes, y 
to zoom on y-axis only, x to 
zoom on x only.  After entering 
zoom mode, press i to zoom in, 
or o to zoom out, or click to set 
the bounding box.  Press w to 
restore original axes. 

Fit line -- Press f to enter fitting mode, 
then click to set bounding box.  
Fit centroid and FWHM for the 
selected region will be 
displayed in the bar below the 
plot.  Additional statistics are 
printed to the terminal window. 

Clear 
current 
mode 

-- Press c or q. 

Table 5: Xvspec features 
 
 

7.6 FLITECAM Reduction 

FLITECAM data reduction with Redux follows the data reduction flowcharts given in section 3.  
At each step, Redux attempts to determine automatically the correct action, given the input data 
and default parameters, but each step can be customized as needed.  Some key parameters to note 
are listed in the following subsections. 

7.6.1 Imaging Parameters 
• Load Data: 

o Save intermediate files: Check this box to save a file after each reduction step. 
o Check headers: By default, Redux will abort reduction if the input header 

keywords do not meet requirements.  Uncheck this box to attempt the reduction 
anyway. 

o Apply flux calibration factor: Uncheck this box to skip applying flux calibration 
factors to the header of the coadded data product, and to skip generating the 
calibrated data product. 

• Correct Nonlinearity: 
o Skip linearity correction: If checked, Redux will skip applying the linearity 

coefficients to the raw data.  This option should only be used for testing. 
o Linearity coefficients: If desired, a file containing a non-default set of linearity 

coefficients may be selected.  This option will also generally be useful only for 
testing. 
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• Clip Image: 
o Use header data section: Check to use a data section defined in the ARRAY0 

keyword in the header of the first file in the reduction set.  The keyword should 
contain the x-size and y-size of the data section to use.  For example, 
ARRAY0=‘100,200’ will clip the data to a 100x200 pixel section centered on the 
center of the array. 

o Data section (x): Enter a pixel range to use as the data section range in the x-
direction.  Values should be entered as x1-x2, e.g. 170-930 will use the pixels 
x=170 to x=930. 

o  Data section (y): Enter a pixel range to use as the data section range in the y-
direction.  Values should be entered as y1-y2, e.g. 200-800 will use the pixels 
x=200 to x=800. 

• Make Flat: 
o PSF FWHM: Set to the expected FWHM of point sources to mask in the input flat 

frames. 
o Object masking factor: Factor to multiply the FWHM by to define the size of the 

apertures used to mask stars. 
o Select alternate processed flat: If specified, the provided FITS file will be used in 

place of generating a flat field from the input data. 
• Make Sky: 

o PSF FWHM: Set to the expected FWHM of point sources to mask in the input sky 
frames. 

o Select alternate processed sky: If specified, the provided FITS file will be used in 
place of generating a sky frame from the input data. 

• Subtract Sky: 
o Subtract median sky: If checked, the background will be determined from the 

median of each frame, rather than from the flat/sky frame. 
• Register Images: 

o Registration algorithm: All data defaults to using header data for registration.  
Centroiding is primarily useful for bright, compact objects; cross-correlation may 
be useful for bright, diffuse fields. The ‘Interactive’ registration algorithm allows 
the user to select a common point to (optionally) centroid on in each image.  
Zooming and scaling is not available while running the interactive registration: 
zoom in and set the image scale as needed before clicking ‘Run’ for this step. 

o Interpolation order: Set to 0 to do integer pixel shifts (no interpolation; default), 1 
for bilinear interpolation, or 3 for a cubic interpolation. 

o Cross-correlation reduction factor: Set to 10, 50, or 100.  Larger values start with 
a coarser grid to determine the initial guess at the offset shifts, but will then 
require more iterations to complete the calculation.  Starting with a larger grid 
may make the registration algorithm complete faster.  Default value is 10. 

o Centroid at interactively selected point: Uncheck to use the exact location 
selected by the user; leave checked to use a centroided location near the clicked 
area instead. 

o Override offsets: If registration offsets are known a priori, they may be directly 
entered here.  Enter offsets as comma-separated x,y values, with values for each 
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file separated by semi-colons.  For example, 0.0,0.0;-1.0,1.0 will leave the first 
file unshifted and shift the second file to the left 1 pixel and up 1 pixel. 

• Coadd: 
o Skip coadd: If checked, input files will not be coadded.  Bad pixel masks will be 

computed and attached to the background-subtracted images and written as the 
final output. Calibration factors will be applied to the header of each output file. 

• Flux Calibrate: 
o Recalculate photometry: If selected, and observation is a flux standard, 

photometric fits and aperture measurements on the brightest source will be 
recalculated, using the input parameters below.  Recalculated values will 
overwrite those in the header of the coadded file. 

o Source position: Enter the approximate position (x,y) of the source to measure.  If 
not specified, the SRCPOSX/Y keywords in the FITS header will be used as the 
first estimate of the source position.  If SRCPOSX/Y are not found, a peak finding 
algorithm will attempt to find the brightest point source in the field as a starting 
point. 

o Subimage size for profile fit: Smaller subimages may sometimes be necessary for 
faint sources and/or variable background. 

o Starting FWHM for profile fit: Specify in pixels.  This parameter should be 
modified only if the PSF of the source is significantly larger or smaller than usual. 

o Profile type: Moffat fits are the default, as they generally give a more reliable 
FWHM value.  However, Gaussian fits may sometimes be more stable, and 
therefore preferable if the Moffat fit fails.  Lorentzian fits are rarely used. 

 

7.6.2 Spectroscopy Parameters 
• Load Data: 

o Save all intermediate files: Check this box to save a file after each reduction step. 
o Check headers: By default, Redux will abort reduction if the input header 

keywords do not meet requirements.  Uncheck this box to attempt the reduction 
anyway. 

o Wavecal file: Enter a wavelength calibration file to use in place of the default file.  
This option will generally be useful only for testing. 

• Reduce Image: 
o Pair subtract: If checked, files will be pair-subtracted in the order they were 

taken, according to the DATE-OBS keyword in their headers.  
o Divide by flat: If checked, and a flat is loaded along with the sources, the input 

images will be divided by the processed flat.  If the default flat is being used, it 
will not be used to flat-correct the data, regardless of the value of this parameter. 

o Coadd images: If checked, all input images will be coadded, after pair subtraction 
(if desired).  This option may be useful for extracting spectra from faint sources. 

o Combination statistic: Select the algorithm to use to coadd images. 
• Make Profiles 

o Row fit degree: Typically a third-order polynomial fit is used to calculate the 
smooth spatial profile.  Occasionally, a higher or lower order fit may give better 
results. 
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o Subtract median background: If checked, and the SRCTYPE is not 
EXTENDED_SOURCE, then the median level of the smoothed spatial profile 
will be subtracted out to remove residual background from the total extracted 
flux.  This option is appropriate as long as the slit is dominated by background, 
rather than source flux.  If the spatial profile dips below zero at any point (other 
than for a negative spectrum), this option should be deselected. 

• Find Objects: 
o Number of apertures: Enter the number of apertures to try to find automatically.  

The default is to look for two apertures for nod-on-slit mode, and one otherwise.  
If the observation has SRCTYPE=EXTENDED_SOURCE, the default is to fix 
the aperture to the center of the slit. 

o Guess: Enter a guess value for the aperture to use as a starting point.  Values are 
in arcseconds across the slit (refer to the spatial profile).  Separate multiple 
apertures by commas; separate values for multiple files by semi-colons.  For 
example, 3,8;2,7 will look for apertures near 3” and 8” in the first image and 2” 
and 7” in the second image.  If there are multiple files loaded, but only one 
aperture list is given, the aperture parameters will be used for all images. 

o Fix: Enter a value to use as the aperture center.  The format of this parameter is 
the same as for the guess parameter, but no fit will be done to attempt to refine the 
position: it will be used as entered. 

o Exclude orders: Enter comma-separated numbers to identify specific orders to 
exclude from spectral extraction.  This option is not used for FLITECAM, as it 
has only a single order. 

• Trace Objects: 
o Fit trace?: Select the algorithm to use to trace the aperture center across the array.  

Auto will use the SRCTYPE keyword to decide: if 
SRCTYPE=EXTENDED_SOURCE, it will fix the trace to the aperture center.  
Otherwise, it will fit Gaussians to the continuum to determine the trace. Select Fix 
or Fit to override the automatic choice. 

• Set Apertures:  
o Auto: If checked, the pipeline will use the header parameters to determine how to 

set the apertures automatically.  If SRCTYPE=EXTENDED _SOURCE, it will 
perform a full-slit extraction.  Otherwise, it will automatically determine a PSF 
radius, aperture radius, and background regions to use in optimal extraction. 
Uncheck auto to use either of the next two parameters. 

o Subtract background: If checked, and auto is not checked, then the pipeline will 
attempt to determine suitable background regions from the median spatial profile.  

o Set PSF radius for optimal extraction: If checked, and auto is not checked, then 
the pipeline will attempt to determine a PSF radius from the median spatial 
profile.  If a PSF radius is not set at this step, standard extraction will be used as 
the extraction method. 

o Override parameters: If numbers are entered for any of the following parameters, 
they will be used as the aperture values.  No automatic fit will be done for the 
specified parameter.  For each one, values should be given in arcseconds across 
the slit (refer to the spatial profile).  Separate multiple apertures by commas; 
separate values for multiple files by semi-colons. 
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§ Override aperture radius: Enter a value to use as the aperture radius. 
§ Override PSF radius: Enter a value to use as the PSF radius.  This number 

should be larger than the aperture radius. 
§ Override background regions: Enter a range to use as the background 

region.  For example, 0-1,8-10 will use the regions between 0” and 1” and 
between 8” and 10” to determine the background level to subtract in 
extraction. 

o Override aperture signs: enter either 1 or -1 to override the automatic 
determination of the aperture sign from the spatial profile.  If the value is -1, the 
spectrum will be multiplied by -1.  Separate multiple apertures by commas; 
separate values for multiple files by semi-colons. 

• Extract Spectra: 
o Extraction algorithm: If set to auto, the pipeline will use standard extraction for 

SRCTYPE=EXTENDED_SOURCE and optimal extraction otherwise.  To 
override this, select either optimal or standard. 

o Use median profile: By default, the pipeline uses a wavelength-dependent spatial 
profile for extraction, but this method may occasionally give poor results, if the 
signal-to-noise in the profile is low.  Check this option to use the median spatial 
profile across all wavelengths instead. 

o Fix bad pixels: The pipeline usually uses the spatial profile to attempt to fix bad 
pixels during extraction.  Occasionally, this results in a failed extraction.  
Uncheck this box to extract the spectra without bad pixel correction. 

o Background fit order: Set to a number greater than or equal to zero for the 
polynomial order of the fit to the background regions.  The default is zero for 
FLITECAM. 

o Bad pixel threshold: Enter a value for the threshold for a pixel to be considered a 
bad pixel.  This value is multiplied by the standard deviation of all good pixels in 
the aperture at each wavelength bin. 

• Combine Spectra: 
o Combine apertures: If unchecked, spectra from separate files will be combined, 

but separate apertures will remain separate in the output file. 
o Scale to median: If checked, each spectrum will be scaled to the median across all 

spectra before combination. 
o Correct spectral shape: If checked, each spectrum’s shape will be corrected to the 

shape of the first spectrum before combination. 
o Combination statistic: Select the combination method.  The default is a robust 

weighted mean. 
• Refine Wavecal: 

o Select feature interactively?: If unchecked, a default zero-point shift will be 
looked up in a configuration table.  If checked, a GUI window will pop up, 
allowing selection and editing of any number of spectral feature.  To select the 
feature, click on the spectrum, then in the new window, type f and click on either 
side of the desired feature.  From the GUI window, click Add from Plot, then 
edit the wavelength to the known value.  Click Done when finished.  The mean 
shift calculated from all selected features will be applied as a zero-point shift to 
the wavelength calibration of all output spectra.  
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o Override shift: Enter a value in dispersion units (i.e. μm) to use as the zero-point 
shift in wavelength calibration. 

 
 
 

8 DATA QUALITY ASSESSMENT 

After the pipeline has been run on a set of input data, the output products should be checked to 
ensure that the data has been properly reduced. 
 
For imaging data: 

• Check the final flat frame by comparing it with the raw image.  All instrumental artifacts 
(areas of low quantum efficiency, obscurations in the optical path, and other systematics) 
that are present in the raw frame should be present in the flat.  Sources in the raw image 
should not appear in the flat.  Also check that the flat-fielded image does not contain any 
residual artifacts. 

• Check for excessive hot or cold pixels in the coadded image.  Bad pixels should be 
ignored in the coadding process. 

• Check that the background was correctly subtracted.  The counts in regions containing no 
sources should be zero, within the standard deviation. 

• Check that the registration process calculated offsets correctly: look at all the registered 
images to verify that all sources appear at the same location on the array. 

 
For grism data: 

• Check the output to the terminal (or the log, in the case where the pipeline has been run 
by the automatic DPS system) for warnings or errors.  Non-fatal warnings will be 
prepended with the string WARNING.  Fatal errors will be prepended with the string 
ERROR. 

• Check that the expected files were written to disk: there should, at a minimum, be a 2D 
image (IMG), an extracted spectrum (SPC), and a calibrated spectrum (CAL). 

• Look at the intermediate extracted spectra in xvspec: the positive and negative apertures 
of the same object should look similar.  Spectra from separate observations of the same 
source in the same mode should look similar. 

• Compare the signal-to-noise in the extracted spectrum to the reduced image.  If the target 
seems bright in the reduced image, but the spectrum looks noisy, it may be that the 
aperture centers were not defined correctly.   

• Check the aperture parameters recorded in the pipeline output and in the output file 
headers.  The calculated aperture and PSF radii should have similar values for all 
apertures. 

• Check the extracted spectra for excessive outliers.  Most bad pixels should be removed in 
the extraction process.  If they are not, it may be helpful to use the median spatial profile, 
or set the bad pixel threshold lower. 
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9 APPENDIX A: SAMPLE FSPEXTOOL CONFIGURATION FILE 

Sample FSpextool instrument configuration file, usually located at 
fspextool/Instruments/FLITECAM/Data/FLITECAM.dat. 
 
# 
# Generated by W. Vacca, 19 March 2012 
# 
# This is the calibration file for the FLITECAM spectrograph on SOFIA. 
# Note the values must be in the correct order, but can have any number of  
# spaces/comments between them. 
# 
#============================================================================ 
# 
 INSTRUMENT=FLITECAM 
 NCOLS=1024 
 NROWS=1024 
 STDIMAGE=1024 
 PLOTWINSIZE=700 512 
 FILENAME=FILENAME 
 EXPTIME=EXPTIME 
 TIME=TIME_OBS 
 POSANGLE=ROT_ANGL 
 HA=None 
 AIRMASS=None 
 NINT=4 
 BADPIXMASK=None 
% 
%CAL BASE 
% 
 CALMODULE=mc_flitecamcals1d 
% 
%FILE READ MODE 
% 
 FILEREADMODE=Filename 
 IPREFIX=F 
 OPREFIX=r 
 SUFFIX=*.fits* 
 FITSREADPROGRAM=mc_readflitecamfits 
 HEADCOMBPROGRAM=mc_flitecamdcshdr 
 YUNITS=DN/s 
 YTITLE=f (!5DN s!u-1!n) 
 XUNITS=um 
 XTITLE=!7k!5 (!7l!5m) 
% 
% Reduction Mode 
% 
 REDUCTIONMODE=A-B 
% 
% Combine Base Information 
% 
 COMBMODE=A 
 COMBSTAT=Median (Median Error) 
 COMBTHRESH=8.0 
 COMBODIR=proc/ 
% 
%  Sky Base Information 
% 
 SKYSTAT=Robust Weighted Mean 
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 SKYTHRESH=8.0 
% 
% Profile Parameters 
% 
 YBUFFER=2 
 OVERSAMP=1 
 ATMOSTHRESH=0.7 
% 
% Point Source Base 
% 
PSNAPS=2 
PSPSFRAD=9.0 
PSAPRAD=3.0 
PSBGSUB=1 
PSBGSTART=9.0 
PSBGWIDTH=10 
PSBGDEG=0 
PSBGMULT=2.0 
% 
% Extended Source Base 
% 
XSBGSUB=1 
XSBG=0-9,24-36,54-60 
XSBGDEG=0 
% 
% Additional processing base 
% 
 ADDLMODULE=None 
% 
%Other Base Parameters 
% 
 TRACEDEG=2 
 TRACESTEP=7 
 TRACESUMAP=7 
 TRACESIGTHRESH=1 
 TRACEWINTHRESH=5 
 BADPIXELTHRESH=4 
 PLOTSATURATEDPIXELS=1 
 SATURATION=5000 
 CHECKSEEING=0 
 SEEINGTHRESH=3 
 LINCORRECT=1 
 ERRORPROPAGATION=1 
 FLATFIELD=1 
 FIXBADPIXELS=1 
 OPTIMALEXTRACTION=1 
% 
% FITS Header Keywords to Grab 
% ---------------------------- 
 […] 
 
Here follows a list of all keywords required to appear in FSpextool output files.  This list 
includes all keywords listed in Appendix C and all keywords required by the SOFIA DCS. 
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10 APPENDIX B: SAMPLE REDUX PARAMETER FILE 

The following are sample FLITECAM Redux parameter override files for imaging and grism 
modes in JSON format, with all values stored as strings.  If present, the parameter value 
overrides the default defined by the FLITECAM reduction object, or the FSpextool configuration 
file.  If not present, the default value will be used.  The parameters displayed here are the current 
default values. 

 
{ 
 "FLITECAM_IMAGING_REDUCTION": 
  { 
   "Load Data": 
    { 
     "checkhead": "1", 
     "saveimf": "0", 
     "applycal": "1", 
     "outpath": "./", 
     "logfile": "./F0146_FC_IMA_85000375_FLTJ_COA_2016Aug10_14:52:51.log" 
    }, 
   "Correct Nonlinearity": 
    { 
     "skipcor": "0", 
     "coeff": "/Users/mclarke/pipeline/repository/fdrp/cal/FCAM_lc_coeffs_030714.fits" 
    }, 
   "Clip Image": 
    { 
     "hdrdatasec": "0", 
     "datasecx": "186-837", 
     "datasecy": "186-837" 
    }, 
   "Make Dark": 
    { 
    }, 
   "Subtract Dark": 
    { 
    }, 
   "Make Flat": 
    { 
     "psffwhm": "6.0", 
     "maskfac": "6.5", 
     "flatfile": "" 
    }, 
   "Correct Gain": 
    { 
    }, 
   "Make Sky": 
    { 
     "psffwhm": "6.0", 
     "skyfile": "" 
    }, 
   "Subtract Sky": 
    { 
     "medsky": "0" 
    }, 
   "Register Images": 
    { 
     "method": "Header shifts", 
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     "shiftord": "0", 
     "reduc": "10.0", 
     "usecent": "1", 
     "offsets": "" 
    }, 
   "Coadd": 
    { 
     "skipcoadd": "0" 
    }, 
   "Flux Calibrate": 
    { 
     "recalc": "0", 
     "srcpos": "", 
     "fitsize": "138", 
     "fwhm": "6.0", 
     "profile": "Moffat" 
    } 
  } 
} 
 
 
{ 
 "FLITECAM_GRISM_REDUCTION": 
  { 
   "Load Data": 
    { 
     "checkhead": "1", 
     "saveimf": "0", 
     "procpath": ".", 
     "calpath": ".", 
     "wavecal": "default" 
    }, 
   "Make Flat": 
    { 
    }, 
   "Reduce Image": 
    { 
     "pairsub": "1", 
     "flatdiv": "1", 
     "coadd": "0", 
     "statistic": "Robust Weighted Mean" 
    }, 
   "Make Profiles": 
    { 
     "ndeg": "", 
     "bgsub": "1" 
    }, 
   "Find Objects": 
    { 
     "numaps": "", 
     "guess": "", 
     "fix": "", 
     "exclorders": "" 
    }, 
   "Trace Objects": 
    { 
     "trace": "Auto (decide fix vs. fit from source type)" 
    }, 
   "Set Apertures": 
    { 
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     "auto": "1", 
     "bgsub": "0", 
     "optimal": "0", 
     "aprad": "", 
     "psfrad": "", 
     "bginfo": "", 
     "apsign": "" 
    }, 
   "Extract Spectra": 
    { 
     "algorithm": "Auto (decide algorithm from source type)", 
     "medprof": "0", 
     "bgorder": "", 
     "fixpix": "1", 
     "bdpxthresh": "", 
     "debug": "None" 
    }, 
   "Refine Wavecal": 
    { 
     "interactive": "0", 
     "shift": "" 
    }, 
   "Flux Calibrate": 
    { 
     "skipcal": "0", 
     "atranfile": "default", 
     "respfile": "default", 
     "resolution": "", 
     "autoshift": "1", 
     "shiftval": "", 
     "debug": "0" 
    }, 
   "Combine Spectra": 
    { 
     "combineaps": "1", 
     "scale": "1", 
     "correctshape": "0", 
     "statistic": "Robust Weighted Mean" 
    } 
  } 
} 
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11 APPENDIX C: REQUIRED KEYWORDS 

Keyword Type Allowed range Condition Required 
for: 

ALTI_END float > 0, < 60000 * Grouping 

ALTI_STA float > 0, < 60000 * Grouping 

AOR_ID string  * Grouping 

CYCLES int 1 * Data 
reduction 

COADDS int ≥ 1 * Data 
reduction 

DATASRC string ASTRO, CALIBRATION, LAB, TEST, 
OTHER, FIRSTPOINT 

* Archiving 

DATATYPE string IMAGE, SPECTRAL * Grouping 

DATE_OBS string yyyy-mm-ddThh:mm:ss[.sss] * Archiving 

DITHERX float  Dithering Data 
reduction 

DITHERY float  Dithering Data 
reduction 

DIVISOR int ≥ 1 * Data 
reduction 

EXPTIME float > 0 * Data 
reduction 

INSTCFG string IMAGING, GRISM * Grouping 

INSTRUME string FLITECAM * Archiving 

INSTMODE string STARE, NOD_OFFARRAY, 
NOD_ALONG_SLIT, NOD_OFF_SLIT 

* Grouping 

IRAFNAME string  Imaging Data 
reduction 

ITIME float > 0 * Data 
reduction 

MISSN_ID string  * Archiving 

NDR int ≥ 1 * Data 
reduction 

OBJECT string  * Grouping 
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OBS_ID string  * Archiving 

OBSTYPE string OBJECT, STANDARD_FLUX, 
STANDARD_TELLURIC, FLAT, DARK, 
SKY 

* Grouping 

PROCSTAT string LEVEL_0, LEVEL_1, LEVEL_2, LEVEL_3, 
LEVEL_4 

* Archiving 

SLIT string NONE, FLT_SS10, FLT_SS20 * Grouping 

SPECTEL1 string NONE, FLT_DRK, FLT_J, FLT_H, FLT_K, 
FLT_ICE_308, FLT_PAH_329, FLT_Pa, 
FLT_Pa_cont, FLT_NbL, FLT_NbM, 
FLT_L, FLT_Lprime, FLT_M, FLT_B3_J, 
FLT_C4_H, FLT_A3_Hw, FLT_B2_Hw, 
FLT_C3_Kw, FLT_A2_KL, FLT_C2_LM, 
FLT_B1_LM, FLT_A1_LM 

* Archiving, 
grouping 

SPECTEL2 string NONE, FLT_SS10, FLT_SS20 * Archiving, 
grouping 

SRCTYPE string POINT_SOURCE, EXTENDED_SOURCE, 
OTHER, UNKNOWN 

Spectroscopy Data 
reduction 

TABLE_MS float > 0 * Data 
reduction 

ZA_END float >0, <90 * Grouping 

ZA_START float >0, <90 * Grouping 

 


